10S & OS X

O

Operating System OS X I0S
Device Mac iPhone, iPad, iPod, Apple Watch

Framework Cocoa Cocoa Touch

o June 2007 - First iPhone Launch
» Early 2008 — Native Development Kit released
»July 2008 — Apple App Store available to users
500 third-party apps
Over ten million titles downloaded first week




Steve Jobs started NeXT when he left Apple in 1985
NeXT initially made computers & developed software
In 1993 NeXT became a software company

NeXT had developed the NeXTSTEP operating system

Objective-C was selected as the main language by NeXT
for its NeXTSTEP operating system

In 90s Apple was looking for a replacement for Mac OS
In 1996 Apple purchased NeXT for $429 million
NeXTSTEP OS was used as the basis for Mac OS
Purchase of NeXT brought Steve Jobs back to Apple



Native Mobile Apps

Built specifically for a particular OS
10S apps

Written in Objective-C & Swift @l Ject
Android apps n s thOj

Written in Java

ngramwﬁng

What do Objective-C, Swift and Java have in common?
They are all Object Oriented Programming Languages



Class

Template or blueprint

Object

Instance of a class
Properties = Attributes
Methods = Actions = Functions = Events

Message Passing

Objects communicate through messages

Inheritance
The child inherits all property and methods of the parent class

celebrateBirthday

Joe Mary
25 32




System: Have an Intel-based Mac
Download Xcode from the Mac App Store

Xcode is an integrated development environment (IDE)

Xcode provides all of the tools you need to create and
manage your 10S projects and source files

Xcode includes:

10S Simulator

latest version of the iOS SDK
SDK (Software Development Kit)




Development Requirements: 10S Dev Center

» Register as an Apple Developer on 10S Dev Centre
https://developer.apple.com/devcenter/ios/index.action

» 10S Dev Centre gives access to resources:
The latest version of the SDK
Pre-release documentation
Videos
Sample code

[ Developer

iOS Dev Center

Access additional resources in the iOS Dev Center. @EEED

Sign in with the Apple ID you used to register as an Apple Developer, or register for free today.

Development Resources

Documentation and Videos Featured Content
10S Developer Library W Create Apps for i0S 7
View the latest documentation and sample B 105 7 Design Resources
code for 105 7.
W i0S 7 Ul Transition Guide

Getting Started sample Code
Guides Technical Notes
Reference Technical Q&AS W Start Developing i0S Apps Today

W Xcode Cont

uous Integration Guide

Release Notes W App Distribution Guide

W Developing Apps for iPad

0S App Prog

ming Guide

Development Videos
0S Development » WWDC Videos

0S Human Interface Guidelines

W Programming v

th Objective-C

Downloads
. Xcode 5
2 Download the complete developer toolset for building Mac, iPhone, and iPad apps, including the
L Xcode IDE, performance analysis tools, iOS Simulator, and the latest OS X and iOS SDKs.

Technologies  Resources  Programs  Support  Member Center

105 Dev Center

Dev Center Safari Dev Center

Hi, Guest | Registe L

i0S Developer Program

App Review Guidelines
Prepare your apps for the
approval process. P

Learn more »

App Store Resource Center
Get information on
distributing your appon (e

the App Store. Sign in »

News and Announcements
Stay up to date with the
latest Apple developer news
and announcements.

Learn more »

=

Check the status of your pending
i0S Developer Program
enrollment

Signin »



https://developer.apple.com/devcenter/ios/index.action
https://developer.apple.com/devcenter/ios/index.action

App Creation

O

e Launch Xcode

» File > New > Project

® Xcode RallH Edit Editor Product

Tab

View Find Navigate Debug Source Control

Add Files to “Tabbing”... A  Window 08T
Open... 20 File... 8N
Open Recent > Target...
Open Quickly... 0 %0

i ! Workspace... ~%N
Close Window W -
Close Tab Croup 8N

Close “Main.storyboard”  ~ %W Group from Selection

Close Project T #W




App Creation

Choose a template for your new project:

watchOS tvOS macOS  Cross-platform

®

Application

Single View Game
Application

o0

oo

Sticker Pack iMessage
Application Application

-

Master-Detail
Application

-

Page-Based Tabbed
Application Application

Framework & Library

o &

Cocoa Touch
Framework

Cocoa Touch
Static Library

B

Metal Library

preious | (D




Ap

p Creation

Choose options for your new project:

Organization Name:

Organization Identifier

Language

Bundle Identifier:

Devices:

Product Name: |Project0ne

Team: BERMOTECH LIMITED

: Bermotech

: Icom.bermotech

com.bermotech.ProjectOne

;| Swift

_ iPhone

Use Core Data
["] Include Unit Tests
[ Include Ul Tests




App Creation

O




Select Directory

FAVORITES
E. All My Files
© Downloads
2} nargesberry
Macintosh HD
A Applications
[ Desktop
[ Documents
Movies
@) Pictures
J7 Music
DEVICES
() Remote Disc

Source Control: [_| Create git repository on
"~ Xcode will place your project under version control hadea

New Folder




Project Created

B R Qa0

iPhone 7 Plus

8| < > ProjectOne

ProjectOne: Ready | Today at 10:50

0o

ProjectOne
v [ ] ProjectOne
|5 AppDelegate.swift
| ViewController.swift
Main.storyboard
|5 Assets.xcassets
LaunchScreen.storyboard
Info.plist
ProjectOne.xcdatamodeld
» [ | Products

I General

Capabilities Resource Tags Build Settings Build Phases Build Rules

PROJECT

[& Projectone
TARGETS

¥ Identity

Display Name l ProjectOne

Bundle Identifier loom.bermotech.ProjectOne

Version [ 1.0

Build 1

Quick Help

No Quick Help

¥ Signing

Automatically manage signing
Xcode will create and update profiles, app 10s, and
certificates.

Team BERMOTECH LIMITED

Provisioning Profile Xcode Managed Profile ()

Signing Certificate iPhone Developer: Narges Berry Noubar (6C94W...

¥ Deployment Info

Target [10.1

Devices | iPhone

Main Interface [ Main

Device Orientation @ Portrait
") Upside Down
Landscape Left
Landscape Right

Status Bar Style = Default

) Hide status bar
1 Requires full screen

No Matches




Simulator for Testing

Device
l No devices connected to 'My Mac'...

Build Only Device
/" Generic iOS Device

iOS Simulators
W iPad Air
W iPad Air 2
W$ iPad Pro (9.7 inch)
8 iPad Pro (12.9 inch)
8 iPad Retina
PROJECT 8 iPhone 5

R : W§ iPhone 5s
s ViewController.swift Projectd = .

Main.storyboard TARGETS 8 iPhone 6 Plus

.Assets.mm /- . ProjectO 8 iPhone 6s

LaunchScreen.storyboard $ iPhone 6s Plus

Info.plist 8 iPhone 7

ProjectOne.xcdatamodeld v 'Phom 7 Plus
» || Products 8§ iPhone SE

Add Additional Simulators...
Download Simulators...




Program: Set of instructions
Compile : Translate a program

From human language
To computer language

Run: Execution of the translated instructions by the computer

There are 2 ways to compile and run the program

Click on the “Run” button at the top left corner

Press and hold “command” button, then press “R”

Run the Project

Once the project is run, the simulator will appear
At this point it will be blank

v/ \‘

(P>

NS
Run

® O 0O

command &6

.

ud




Main.storyboard
Allows you to design entire user interface in 1 place
Shows app screens and the connection between them

AppDelegate.swift
v |5] ProjectOne
. . v ProjectOne
VleWCOntl'OlleI'.SWIft «| AppDelegate.swift

« ViewController.swift
Main.storyboard
Assets.xcassets
LaunchScreen.storyboard
Info.plist

’| ProjectOne.xcdatamodeld

e Products



Comments and Import Statements

O




What is a storyboard?

v [E] View Controller Scene View
v (© View Controller Content Mode |_Scale To Fill
5] Top Layout Guice Semantic
|| Bottom Layout Guide Tag 0
9 First cspondor Interaction € User Interaction Enabled
it () Multiple Touch

> Storyboars Entry Point mebal 1

Opaque
() Hidden
Clears Graphics Context
() Clip To Bounds
Autoresize Subviews

View Controller - A controller that
manages a view.

 Storyboard Reference - Provides a
| placeholder for a view controller in an
external storyboard.

Navigation Controller - A
controller that manages navigation
through a hierarchy of views.

Table View Controller - A
controller that manages a table view.

Collection View Controller - A
controller that manages a collection
view.

Tab Bar Controller - A controller
that manages a set of view controllers
that represent tab bar items.




Drag and Drop

Put the image or image folder on the desktop

Drag it to the project folder e ——

eeeeeeeeeeeeeeee

Y i

Make sure Destination is checked
This will add the images to the project
Otherwise they will be referenced

Destination Iz Copy items into destination group's folder (if needed)

aaaaa




Access Xcode Objects

e e W3 (- O 5 =EII
IEIEIIDEIIEI

HEEEEEEEE R
EII:IEI-..-.
HE = =06




Every view has a property called alpha
What is alpha and what do its values mean?
Alpha defines the transparency of view objects.

1 1s fully opaque.
0 1is fully transparent



Custom Colour

O







Xcode Objects
Image View & Label

O

* Create a new “Single View Application” project
* Click on Main.Storyboard nomT O o

View

* Click on view on the storyboard Iy wodeSle To i 3

x I~
Tag ol

Py 9 Attribute S Inspector Interaction (¥ User Interaction Enabled

[] Multiple Touch

» Change view Background colour 16

Background | e | |

Tint | EEEE | Default s)

Drawing (¥ Opaque || Hidden
@ Clears Graphics Context
[ ] Clip Subviews
@ Autoresize Subviews

Stretching | 0 'Iéj ‘ 0 ]LEJ
X Y

[ 1= [ I+
L 1)
Width Height




Add an Image to the Storyboard

MyApp | Build MyApp: Succeeded | Today at 00:19

B2 Q A & & 28 <« » | [5 MyApp ) [ MyApp > B Main.storyboard ) [ Main.storyboard (Base) » [E] View Controller Scene » (@ View Controller » | View 0D ® g B O
MyApp View Controller Sc ad View
¥ B 2 targers, ios sok 8.2 v B View Controller Scene W |

v [ MyApp
. AppDelegate.swift
\;] ViewController.swift
[ Images.xcassets
| LaunchScreen.xib
v (] Supporting Files
S] Cake.png
D Info.plist
» []Images
» [ MyAppTests
» [ Products

View Controller
Top Layout Guide
Bottom Layout Guide
v @Vlew
Image View
E Navigation Item
(i First Responder
Exit

» [E Navigation Controller Scene

© )|

UlimageView

wAny hAny

& ol tal ]

Mode | Scale To Fill D)

Tag | of3)

Interaction g User Interaction Enabled
() Multiple Touch

Alpha | 13
Background | e | ¢ |
Tint [ EEEE | Default )|
Drawing 4 Opaque (") Hidden
g Clears Graphics Context
(] Clip Subviews
g Autoresize Subviews
Strelching‘ D‘@ [ D‘@
X Y
1 a1l
Width Height
D6

View Controller - A controller that supports the
fundamental view-management model in iOS.

98 | 4 » | [ Automatic » ViewController.swift - No Selection

|+ x

import UIKit
class ViewController: UIViewController {

override func viewDidLoad() {
super.viewDidLoad()

Navigation Controller - A controller that
manages navigation through a hierarchy of views.

Table View Controller - A controller that
manages a table view.

Tab Bar Controller - A controller that manages a
set of view controllers that represent tab bar items.

Split View Controller - A composite view
controller that manages left and right view
controllers.

Page View Controller - Presents a sequence of
view controllers as pages.




»Click on Main.storyboard
»Click on the Objects Library
»Drag an “Image View” to the storyboard

»Change the width and height of the image
Click on the Image View on the storyboard
- Click on the Size Inspector (ruler)

o Change Width to 200 H
o Change Height to 200

D { @ 3

Image View - Displays a single
image, or an animation described by
an array of images.

X Y
Width Heigh

Constraints
Content Hugging Priorit: y

H al | 250

V 1250

Content Compression Resistance Priorit Y

H 1750

Intrinsic Size | Default (System Defined) +



Add an image to the “Image View”
Add an image to your project
Click on the “Image View”
- Attribute inspector <}
- Image View
- Select Image

@ v B O
Image View
Image ' Cake.png
Highlighted

State Highlighted



Click on Main.storyboard

Click on the Objects Library

Drag a “Label” to the storyboard

Double click on the label and change its text

= (® Labell



Customise Label Font

O

* Click on the label
¢ > Attribute Inspector <+
* > Label
*» 2> C(ClickonT
* - Customise label fon:

sboard » Main.s...(Base) » [E View C...Scene ) ([ View Controller » D View » Happy Birthday 0 ® g E ©
Label

Text | Plain

€’o<

=

‘ @ l Happy Birthday

* Run the App! = o

+ Font | Marker Felt Thin 33.0

| ——

=]
J& e

Font | Custom

Family | Marker Felt
Style | Thin

Behavi

:)
s
s
Baseli Size l 33 ’@
Line Bre  Done |

Autoshrink | Fixed Font Size 3
|| Tighten Letter Spacing

Highlighted | NENEN | Default : |
Shadow | =1 | Default

i
Shadow Offset | 0 l@ [ -1 ]@
Horizontal Vertical

D6 d

Label Label - A variably sized amount of static text.




Change the background colour

self.view.backgroundColor = UIColor.orange

Set Image of an Image View
myImage.image = UIImage(named: “image.png")

Changing the text of a label
myLabel. text = “New Text";

Making an object invisible
myObject.alpha = 0

Animate button to fade
UIView.animateWithDuration(10.0, animations:
{self.fadeButton.alpha = 0})

Change the colour of label
myLabel.textColor = UIColor.red



Navigation
Action Segue (modal)

O




Add button to first ViewController
Add a second ViewController
Click on Button on first ViewController
Press Control
Drag to second ViewController and release
Select Present Modally from the drop down

Action Segue
Show
Show Detail
Present Modally

Present As Popover
Custom

Non-Adaptive Action Segue
Push (deprecated)
Modal (deprecated)




Click on Segue
Go to Attribute Inspector
Transition
Select from:

Cover Vertical
Flip Horizontal
Cross Dissolve
Partial Curl

Peek & P¢

L Jodol < <



Page Navigation

» How to navigate from one page to another and back?
» Add a button to view controller from object library

» Add another view controller to the storyboard

» Click on the button on page 1

Action Segue

o Press Ctrl Snow

Show Detail

Present Modally

» Drag to second view controller e

Custom

o SeleCt ShOW Non-Adaptive Action Segue

Push (deprecated)
Modal (deprecated)




Navigation implemented

O

o Clicking the button will navigate to the 2nd page

‘ View Controller ‘ ®@ ®




View Controller Classes

O

» Each View Controller in the storyboard must have a
“ViewController” class assigned to it

» Creating a View Controller Class
> File > New > File

m Edit View Find Navigate Editor Product Debug Sot

Tab 8T
Add Files to “asdf"... A  Window TRT €
I G W File... %N &
Open Recent »  Target..
Open Quickly... oo  Project. 3N
Wnrkenare ~ SN




Creating a “ViewController” Class

Choose a template for your new file:

watchOS  tvOS  macOS

8§ @ 8

Ul Test Case Unit Test Case Playground
Class Class

R B R B

Objective-C File Header File

User Interface




Creating a “ViewController” Class

O

Class: SecondViewController
Subclass of: UlViewController v

| Also create XIB file

Language: | Swift n




View Controller Class Assignment

O

» Storyboard View Controller
> Must be linked to the created ViewController class

» 2> Click on View Controller on Storyboard -

Identity Inspector - Select class from dropdown
DeGHET I O

B &2 Q AN © 2 o @ |8 < [ Projectone ) || ProjectOne Main.storyboard ) 8§ Main.storyboard (Base) View Controller Scene ) (L) Two View Controller O ® T B O
v [ ProjectOne » [E view Controller Scene ( — ) CISTOMCIES
v | 7] ProjectOne Tero View Controller S o ® B Class ITwoviewControlIer ©
: v o View Controller Scene
| AppDelegate.swift =) Two View -_— -— Module
5| ViewController.swift ¥ (© Two View Controller
Main.storyboard E] Top Layout Guide Identity
~ . N E Bottom Layout Guide
s/ TwoViewController.swift D View Storyboard 1D
Assets.xcassets ) First Responder Restoration 1D
LaunchScreen.storyboard : -
£ | [ Exit Use Storyboard ID
=) Info.plist

N v Navigation Controller Scene
E’f_] ProjectOne.xcdatamodeld User Defined Runtime Attributes

v (£) Navigation Controller
» | | Products

Key Path Type Value
Navigation Bar Y P

{3 First Responder
[ Exit

» Storyboard Entry Point

. - . . +
Relationship "root view controller”...
Document




Xcode Object
Button

O

* How to add a button the the View Controller?

= Click on “Objects Library” DO

- Type “Button” in the Search field Button - Intercepts touch events and
Button sends an actip'n message to a target 0D ® g B O
= Drag a “Button” to the storyboard object when it’s tapped. Button
Type | System
» Go to Attribute Inspector e
Next
Font Palatino Bold 40.0

Text Color HEEE Default
Shadow Color =1 Default

Image

(L oloke

the title, text colour, font typ

Background

o Shadow Offset 0 0
1 I I I age ° Width Height

|| Reverses On Highlight
Drawing [_| Shows Touch On Highlight

Highlighted Adjusts Image

Disabled Adjusts Image




Button Image

(Base) ) [E] View C...r Scene » (@) View Controller » || View »

Button

T —

B S—
O
fon[syem 180 (1]

N I a—
N =TT ra—
Image parispng |v|
backgroun [Deaut Background mage |

shadowoffset | o[J[ o]
Width Height
(| Reverses On Highlight
Drawing | Shows Touch On Highlight
@ Highlighted Adjusts Image
g Disabled Adjusts Image
Line Break | Truncate Middle B

Edge
o Y O N O

Control

Alignment [ [ |




Navigation Bar and Toolbar

O

v [ view Controller Scene
v () view Controller
ﬂ Top Layout Guide
|2 Bottom Layout Guide
v [C] view
v E Navigation Bar
» [<] Title
» [E) constraints
v [...| Toolbar
[~ save
[~ Flexible Space
[~ Done
» (&) Constraints
» (& constraints
i First Responder
Exit
~ Storyboard Entry Point




Click on the ViewController on the Storyboard
Editor - Embed In - Navigation Controller
Navigation Controller and Top Navigation bar added



< Navigation Item - Represents a

From Object Library st e ngton o, i
Add a Navigation Item to the top of the bar
Double click on it and change the title

@ Xcode File Edit View Find Navigate Editor Product Debug Source Control Window Help 3
| ™ » A TopNavigationBar ) g iPhone 7 Plus TopNavigation8ar: Ready | Today at 21:43
| < TopNavigationBar ) [11] TopNavigationBar ) [ Main.storyboard ) [l Main.storyboard (Base) ) B View Controller Scene ) (3) View Controller
Jvigate
[ ol
4
Module
Tog n
1 Identity
-

Use Storyboard ID

User Defined Runtime Attributes

KeyPath  Type value
¥
Document
abel
x
- Object D BYZ-38-10r

Lock | Inherited - (Not

P

[0 Viewas:iPhone7 («C rR) 75% B tof fa @ navigation




Navigation Bar and Toolbar

Navigation Controller




Add another ViewController to your Storyboard
Click on the Bar Button Item
Press Ctrl
Drag to the next ViewController

Click on Show
Back Button will be added automatically



| P & ©
Bar Button Items are used for T
TOOlbar ldentsi:ler i::idoenmd
Navigation Bar Tint ( ==1 Defat

Click on “Objects Library”

Type “Bar Button Item” in the search field

Drag a “Bar Button” to the storyboard

Click on the button

> Attributes Inspector [[] @ [ @ & X 11 + L[]

Bar Button Item

Identifier
Try different identifiers and see what happens



We are going to create an app with a tab bar

Delete the current View Controller
—>Click on it > Press “delete”

Go to the “Objects Library” & enter “tab bar” in the search field
Drag the “Tab Bar Controller” to Main.storyboard

Tab Bar Controller
UlTabBarController

Manages a set of view controllers, each of which represents a 8]
tab bar item. Each view controller provides information about

its tab bar item and supplies the view to be displayed when the
item is selected.

Done



Tab Bar Controller Added

O

View Controller
e[ ]
# Is Initial View Controller
Layout (@ Adjust Scroll View Insets

Tab Bar Controller (] Hide Bottom Bar on Push
¥ Resize View From NIB
("] Use Full Screen (Deprecated)




Add third Tab




* Add the third View Controller to Tab Bar Controller

Click on the Tab Bar Controller

Press “Control”
With the mouse

Link the Tab Bar Controller to the third View Controller

Let the mouse go
Select “view controllers”
from Relationship Segue

Manual Segue
show
show detail
present modally
popover presentation
custom

Relationship Segue
view controllers
Non-Adaptive Manual Segue
push (deprecated)
modal (deprecated)



The third Tab has been added
O




o Click on the first View Controller

* Click on Show Document Outline
If “Document Outline” not already displayed

* Click on View " ot =
» Click on Attribute Inspector .3
» Change Background Colour — i
From White to another colour e
* Let’s run the app! i




Xcode Object

O




Add objects to the Storyboard

O

*Create a new “Single View Application” project
*Click on Main.storyboard
*Click on the Objects Library
» Drag the following to View Controller
* Switch
* Image View
* Label
*Add an image to the “Image View”

0D {} & =




* Click on the “Assistance Editor”
This will display the ViewController.swift

» Click on the switch on storyboard
Press “control”

Drag to the ViewController.swift file

The IBOutlet connection window will appear
o Populate Name field

» Create IBOutlet connection for image and label

Connection | Outlet
Object View Controller
Name
Type UlSwitch

Storage | Weak

Cancel Connect



» Create connection for image and label

Click on “Image View” on storyboard
Press “control”
Drag to the ViewController.swift file
o The IBOutlet connection window will appear
Populate Name field

Click on “Label” on storyboard
Press “control”
Drag to the ViewController.swift file
o The IBOutlet connection window will appear
Populate Name field



Create IBOutlet Connection

O

import UIKit
class ViewController: UIViewController {
@IBOutlet weak var myLabel: UILabel!

@IBOutlet weak var myImage: UIImageView!
@IBOutlet weak var mySwitch: UISwitch!




Insert and Implement Switch Action

*» > Storyboard

e Click on switch-> Ctrl > Drag to ViewController.swift file
» Connection window will appear

o Enter switchName Connection | Action
» Select Action from the Connection dropdown RLEEL MhELEER Rl
Name
. ) Type |id v |
» Switch has 2 Boolean states Event | Value Changed '
Arguments | Sender
= On @IBAction func switchAction(_ sender: Any) ~ R
{ . Cancel | Connect
O Off if mySwitch.isOn
{

myImage.alpha = 1
myLabel.text = "Goal"

}

else

{
myImage.alpha = @
myLabel.text = "No Goal"

}

}




Xcode Object
Slider

O







Create a new “Single View Application” project
Click on Main.storyboard

Click on the Objects Library
Drag a slider to the storyboard
Change View Background colour

0D {}] & =W



Slider Values

vawe[ o[

Minimum Maximum

- os[d

Current

Min Image

Max Image

Min Track Tint | == | Default $

Max Track Tint | == | Default :

Thumb Tint | Default :

Update Events @ Continuous




Slider Properties

O

- Click on the Slider on the storyboard
- Go to Attribute Inspector
- Edit following fields:

- Value

- Minimum

- Maximum

' & View Co...r Scene ) () View Controller ) || View ) < » My Slider O & O B OB
Slider
Value 1.5
Minimum 0°
Maximum 3|1
+  Min Image
o




Click on the “Assistance Editor”

Click on the slider on story board
Press “control”

Drag to the ViewController.swift file
The IBOutlet connection window will appear

Populate the Name filed

sliderName

Connection | Outlet
Object View Controller
Name
Type |UlSlider

Storage | Weak

Cancel



- Storyboard

Click on slider > Ctrl > Dragto
ViewController.swift R o—

Name |

Connection window will appear

Event | Value Changed

Arguments | Sender

Enter sliderName
Make IBAction connection

° c__ __ N _ax*_ 1 _
Select Actlon ?IBAction func changeColour(_ sender: Any) )down
{
1f mySlider.value < 1
{
self.view.backgroundColor = UIColor.green

}
else if mySli 3 2
{

1 iew lor UIColor.red
}
else
{

1 U 1 UICol ang
}



Auto Layout
O




Pin Menu

Add New Constraints

Spacing to nearest neighbor

() @ widn
O @heim
| & equal widths

(@] Equal Heights

() [B) Aspect Ratio

B aign
Update Frames

Add Constraints

2 Hited A (@ =@




Pin Menu

O

v [E] view Controller Scene

v Q View Controller
ﬂ Top Layout Guide
Q Bottom Layout Guide
v | View
Horizontal Slider
» |E8 Constraints
. First Responder

B Exit

Add New Constraints

Spacing to nearest neighbor

0 B
0 Do

(&) equal widths
' (M) equal Heights
() [B) Aspect Rratio

") EDAign (LeadingEdges )

Update Frames
Add 1 Constraint

(&) (i= i o1 1) (@




CHONONS

lick on the Object
lick on the alignment menu

neck horizontal Centre in Container

ick on Add 1 Constraint

Add New Alignment Constraints
| S—
@ Leading Edges
Eﬂ Trailing Edges
@ Top Edges
Bottom Edges
EB Horizontal Centers
. M B B8 vertical Centers
@ Bas
¥ BB Horizontal Center in Container 0
(B vertical Center in Container 0
Update Fram ne
Add 1 Constraint

(8 |12 [+ red B0 | [ @



Add label to top left
Click on label

Click on Resolve Auto Layout Issues icon g4
Reset to suggested Constraints in View Controller



Resolve Auto Layout issues

1 g o
g.et s try this out nows

Behavior @ Enabled
() Highlighted

Drawing [[) Opaque

D {} & MW
Update Frames N #=
Update Constraints 8=
Add Missing Constraints
Reset to Suggested Constraints XN{#=
Clear Constraints

Update All Frames in View Controller

Update All Constraints in View Controller

Add Missing Constraints in View Controller

Reset to Suggested Constraints in View Controller

Clear All Constraints in View Controller




» Sometimes you want to align objects with each other
» Click on one object

» Press control

» Drag to the second object and let go
» Black menu will appear

* Click on Centre X

Center X
Right

Equal Widths
Equal Heights
Aspect Ratio

Hold Shift to select
multiple then click
away or hit return




* Click on Object

» Press Control

» Drag to the right and let go

» Centre Vertically in Container

& ) Trailing Space to Container
_ Center Vertically In Container

Equal Widths
Equal Heights

Aspect Ratio




Try again and you find objects are not cantered again
Click on object

Orange box indicates where object should be
Resolve Auto Layout Issues g4
Update Frames



Gesture Recognizers

O




Click on Main.storyboard 2 0 o =
Click on the Objects Library

Drag an Image View to the storyboard

Click on the Image View

- Attribute Inspector > Image View = ©

Select image from the drop down list
This is the image that will initially appear

D B8 8 ¥ « ©

Image View
Image confused.png v
Highlighted v

State Highlighted



Enable Interaction and Multiple Touch

O

*Enable Interaction and Multiple Touch
> Click on the Image View on the storyboard

o > Attributes Inspector > View
- Ensure following fields are checked:
> User Interaction Enabled E B v« O

o Image View
© Multiple Touch I ]
Image v |
Highlighted | |v)

State || Highlighted

View

Mode | Scale To Fill :
Tag [ 0 W@

Interaction @ User Interaction Enabled
@ Multiple Touch




Add the swipe gestures

» = Objects Menu
* Select a “Swipe Gesture Recognizer”
» Drag and place it on top of the Image View

L) | 1)
Width Height
Swipe Gesture Recognizer
n UlSwipeGestureRecognizer
Provides a recognizer for swipe gestures which are invoked on D {} &
the view. For recognizing swipes in both directions, you will
need two swipe gesture recognizers. ‘ Y -

. Done |

- = =
BEHE i @|[Q = Q = (® swipe

—




» You will notice that the “Swipe Gesture Recognizer”
appears under the “Document Outline” and if you
right click on it, there should be a connection to the

VieW aS ShOWIl bGIOW: f@’wew Controller Scene
—

Swipe Gesture Recognizer
» Triggered Segues
¥ Outlets

delegate
¥ Sent Actions

selector
¥ Referencing Outlets
New Referencing Outlet
¥ Referencing Outlet Collections
gestureRecognizers ® Image View - inlove...
New Referencing Outlet Collection




Right “Swipe Gesture Recognizer” added

O

o If you click on the “Swipe Gesture Recognizer” on the
Document Outline and then click on the Attribute
Inspector, you will notice that it is a Right Swipe

ure R
13 View Controller wipe 3|
| Top Layout hes|| 1 U
| = Bottom Layo
v Vie ecognizer
[image State @ Enab!
First Respond;
a I Pe nts @ Canc
Exit s
= [_) Dela Be
» Swipe Gestur: ’




Left “Swipe Gesture Recognizer” added

O

» We also need to be able to do a left swipe
» > Objects Menu

> drag another “Swipe Gesture Recognizer over the image View
» This will then appear under “Document Outline

> > Click on it > Attribute Inspector
- > Change Swipe attribute to “Left”

Swipe Gesture Recognizer

Swipe | Left

v [E] view Controller Scene
w (& View Controller
| = Top Layout Guide
|| Bottom Layout...
v . View
1/ Image View -...
@ First Responder
Exit
n Swipe Gesture Reco...
* Swipe Gesture Reco...

Touches | 1 1@
Gesture Recognizer
State @ Enabled
Events @ Canceled in View
|| Delayed Begin
@ Delayed End




Create IBOutlet Connection for Image View

O

» Click on the “Assistance Editor”

This will display the ViewController.swift file
If not, the file can be manually selected

* Click on the image view on storyboard
Press “control”
Drag to the Header File
The IBOutlet connection window will appear
» Populate the Name filed

imageViewName Connection (Gutir

Object [0 View Controller

Name
Type v UllmageView
Storage | Weak

Cancel Connect




Create the Gesture IBOutlet Connection

O

* = Document Outline

» > C(Click on the Right “Swipe Gesture Recognizer”
» Press “Ctrl” - Drag to the Header File

> Connection: Action
o Type: UlSwipeGestureRecognizer

v [E] view Controller Scene

v 5 View Controller
|~ Top Layout Guide
| Bottom Layout...
v . View
1/ Image View -...
@ First Responder
Exit
n Swipe Gesture Reco...
- Swipe Gesture Reco...

Connection | Action

Object @ View Controller

6

8

9
|-
) b
2

H

Name [ swipe

|

Type IUISwipeGestureRecogJ V] g/@er

[ Cancel ) | Connect | 1

s //
7/

Connection | Action

Object [0 View Controller

7/ Name | swipe ]

/7

x Type | UlSwipeGestureRecogi V]

/7. | Cancel ) . Connect |

#ir

@ir
@p1




Connect Left “Swipe Gesture Recognizer”

» = Document Outline

» = Click on the Left “Swipe Gesture Recognizer” >
Press “Ctrl” - Drag to the “View Controller”

Select the Sent Action method implemented as shown below

_—

Gesture Recognizer

' .




Swipe Method Implementation

O

class ViewController: UIViewController
{

@IBOutlet weak var swipeImage: UIImageView!
@IBOutlet weak var myLabel: UILabel!

@IBAction func rightSwipe(_ sender: AnyObject)

{
swipeImage.image = UIImage (named: "happy.png")
myLabel.text = "Happy"

}

@IBAction func leftSwipe(_ sender: AnyObject)
{

swipeImage.image = UIImage (named: "angry.png")
myLabel.text = "Angry"

}
override func viewDidLoad()

{
}

super.viewDidLoad()



Shake Gesture
O




Function called when shake begins

override func motionBegan(_ motion: UIEventSubtype, with event: UIEvent?) {

}

Function called when shake ends

override func motionEnded(_ motion: UIEventSubtype, with event: UIEvent?) {

}



Random Number Generator

O




arc4random()%n Example




iPhone 6s - i0S 10.1 (14B72)
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Steps:
1. Add array image to the project
2. Storyboard: Add an ImageView to the ViewController

3. Make ImageView IBOutlet Connection

4. ViewController Implementation “png



ViewController Implementation

O

@IBOutlet weak var animationImage: UIImageView!

class ViewController: UIViewController {

override func viewDidLoad() {
super.viewDidLoad()

animationImage.animationImages=I[
UIImage (named: "images/1.png")!,
UIImage (named: "images/2.png")!,
UIImage (named: "images/3.png")!,
UIImage (named: "images/4.png")!,
UIImage (named: "images/5.png")!,
UIImage (named: "images/6.png")!,
UIImage (named: "images/7.png")!,
UIImage (named: "images/8.png")!,
UIImage (named: "images/9.png")!,
UIImage (named: "images/10.png")!,
UIImage (named: "images/11.png")!,
UIImage (named: "images/12.png")!

]
animationImage.animationDuration = 1.1

animationImage.animationRepeatCount = 0
animationImage.startAnimating()




Animation code added to viewDidLoad
Animation will start as soon as view is loaded
Exercise:
Click on animationRepeatCount
Click on i to launch Quick Help o

animationImage.animationRepeatCount = 0

D ®
Quick Help
jon var animationRepeatCount: Int { get set }
)escription Specifies the number of times to repeat the animation
The default value is 8, which specifies to repeat the animation indefinitely.
Availability i0S (8.0 and later), tvOS (9.0 and later)
Declared In UIKit
More Property Reference



[.ocal Notification

View Controller




»One application can be active in the foreground at any time

» Local notifications and push notifications are ways

for an application that isn’t running in the foreground
to let its users know it has information for them

» The information could be:
a message
an impending calendar event
or new data on a remote server



» When presented by the operating system

Local and Push Notifications
Look and sound the same

» When users are notified
they can launch the application and see the details

They can also choose to ignore the notification
in which case the application is not activated



Add button to storyboard
Make IBAction connection to ViewController
import frameworks

import UserNotifications

implement Protocols

class ViewController: UIViewController, UNUserNotificationCenterDelegate

Add boolean variable

var 1sGrantedNotificationAccess:Bool = false

Edit ViewDidLoad method - See next slide
Implement IBAction function



viewDidLoad

O




IBAction function

O




Run the app' [T Debug |\

Device

Close the app and wait 10 seconds Reboot

Rotate Left

Click on Simulator > Hardware 2> Home| Peuefe

Notification will appear after 10 seconds
Clicking on the notification message, will open the app






Import framework
Add the audio file to the project
Add Switch to storyboard

Make IBOutlet and IBAction connections for Switch
Start Audio play in ViewDidLoad

Write implementation code to switch audio on and off



Import Framework

O




Switch Function Implementation

O




Audio will be stopped in viewWillDisappear function

override func viewWillDisappear(_ animated: Bool) {
musicPlayer.stop()
s



Xcode Object
Map View




Map Kit View - Displays maps and provides an embeddable interface to navigate
map content.




AutoLayout

MKMapView

Add New Constraints

Hl%l'—'

Spacing to nearest neighbor

(] Constrain to margins

idth
[ (&) Height
0 E Equal Widths
0 m Equal Heights
() [ Aspect Ratio

-
Upcate Frames

Add 4 Constraints




Click on MapView

Go to Attribute Inspector

Enable User Location, Scale and Traffic
Choose Map Type (Map, Satellite or Hybrid)

Map View
Type Standard (v
Allows £4 Zooming o Scrolling
.4 Rotating vd 3D View
Shows £4 Buildings .4 Compass
4 Scale 4 Traffic

4 Points of Interest
o4 User Location



import UIKit
import MapKit
import CoreLocation

class ViewController: UIViewController{
@IBOutlet weak var myMap: MKMapView!

override func viewDidLoad() {
super.viewDidLoad()

= CLLocationCoordinate2DMake(51.546785, -0.179111)
MKCoordinateSpanMake(0.003, 0.003)
MKCoordinateRegion(center: location, span: mySpan)

let location
let mySpan =
let region =

myMap.setRegion(region, animated: true)

let myAnnotation = MKPointAnnotation()
myAnnotation.coordinate = location
myAnnotation.title = "Bermotech Office"
myMap .addAnnotation(myAnnotation)



Exercise

O




Scroll View

O




Storyboard
Add ScrollView to your added View

Add missing constraints
Add Label in Centre
Add missing constraints
Make ScrollView IBOutlet connection



ScrollView ViewController Implementation

O







Storyboard
Add WebView
Implement AutoLayout
Make IBOutlet Connection
ViewController.swift
Load WebView URL request in ViewDidLoad
Info.plist
Custom 10S Target Properties
App Transport Security Settings
Allow Arbitrary Load - set to YES



| Web View - Displays embedded
content and enables content
| navigation.

Storyboard

Add New Constraints

H?H

Spacing to nearest neighbor
] Constrain to margins
) [E) width 375
) [E) Height
O B equal widths
O @ equal Heights
() [ Aspect Ratio

[~ &) Align | Leading Edges <

Update Frames
Add 4 Constraints

SN == N




ViewController

O




- Add row
- App Transport Security Settings
- Expand App Transport Security Settings
- Click on +
- Add Allow Arbitrary Loads
- Set to YES

Duriui - YU nw o U
v App Transport Security Settings > dictionary E
Allow Arbitrary Loads A~ ©O@ Boolean ~ NO
Bu) Allow Arbitrary Loads in Web C... A APPL
Lo¢ Exception Domains a en

<>
03

» Required device capabilities



Info.plist

¥ Custom iOS Target Properties

Key Type Value

Bundle versions string, short
Bundle identifier
InfoDictionary version
Main storyboard file base name
Bundle version
Launch screen interface file base name
Executable file
Application requires iPhone environm...
Bundle name
» Supported interface orientations
v App Transport Security Settings
Allow Arbitrary Loads
Bundle OS Type code
Localization native development region
» Required device capabilities

String 1.0

String $(PRODUCT_BUNDLE_IDENTI
String 6.0

String Main

String 1

String LaunchScreen

String $(EXECUTABLE_NAME)
Boolean YES

String $(PRODUCT_NAME)
Array (4 items)

Dictionary (1 item)

Boolean YES

String APPL

String en

Array (1item)

P OO OH OO




LLocalisation

O




Create New SingleView Project

Add labels to ViewController
Make IBOutletConnections



Add Localization

Info Build Settings

PROJECT
| PROJECT | et Target

B SwiftLocalisation

TARGETS i0S Deployment Target

A SwiftLocalisation

» Debug
» Release

+

Use  Release for command-|i

¥ Localizations

Language

English — Development Language

French (fr)

German (de)

Chinese (Simplified) (zh-Hans)
Chinese (Traditional) (zh-Hant)
Japanese (ja)

Spanish (es)

Spanish (Mexico) (es-MX)

italian (i




Loocalization added

O

¥ Localizations
Language

English — Development Language 2 Files Lo...




Edit Scheme

/- . SwiftLocalisation Running SwiftLocalisation on iPhone 7 Plus
A SwiftLocalisationG

=2 Q A & SwiftLocalisation ) [7]S..n ) B .. ) = M..) ) B Vv..e ) (C) View Controller ) [
S e T Edit Scheme...

New Scheme...
w [ SwiftLocalisation Manage Schemes..

s/ AppDelegate.s Layout Guide
3] ViewController.swift || Bottom Layout Guide
v rd

Main.storyboard (Base) Apple
D Main.strings (German) Lemon
[E5] Assets.xcassets ] Fir‘st Responder
» ] LaunchScreen.storyboard Exit
Info.plist
SwiftLocalisation.xcdatamodeld

~> Storyboard Entry Point

» || Products




Change Application Language

@ Xcode File Edit View Find Navigate Editor Product Debug Source Control Window Help ¥ ¥ @ F I W) 9% %) Frios15 Q
| & |

o ) B /A swiftLocalisation ) g iPhone 7 Plus SwiftLocalisation: Ready | Today at 05:15 G O =

B2 Qa o o & b O

v [ SwiftLocaiisation 7 SwiftLocalisation ) i iPhone 7 Plus B

v [ SwiftLocalisation - -
[3) AppDelegate.switt Info Arguments Options Diagnostics No Quick Help
s ViewController.swift »p g:: . Core Location € Allow Location Simulation [ISsachDochnentationl]

o Search Documentation

v 5 Main.storyboard
Main.storyboard (Base)
|| Main.strings (German) 4y Profie
|5 Assets xcassets Release

» 1) LaunchScreen.storyboard

Default Location = None

Application Data | None

Routing App Coverage File  None

Tow

| Info.plist Background Fetch (| Launch due to a background fetch event
[{%) SwiftLocalisation.xcdatamodeld
[ Products Localization Debugging () Show non-localized strings

Application Language | System Language

Application Regiof S i T

XPC Service ~ Germany
United Kingdom

Queue Debuggin  Africa

Americas
Asia
Europe
Oceania

Duplicate Scheme Manage | Shared

YVvYVYYVYY

006 s

La b Label - A variably sized amount of
€] tatic text.

+(® OH| ® ] 88 (@ tabel




Application Region

O

Application Language German

Application Region = Germany B




Picker View

Picker View - Displays a spinning-
wheel or slot-machine motif of




Storyboard:
From Object Library add:
Label
PickerView
Complete AutoLayout
Make IBOutlet Connections for
PickerView and Label




Click on ViewController on Storyboard

Click on Connections Inspector ©

Connect Label and PickerView to ViewController
ViewController becomes the delegate

@ < L] & O
O @& T B O

Triggered Segues

(i

Outlets
mvLabel % My Labe O,
myPicker % My Picker @)

searchDisplayController

view



Protocol Implementations:
UIPickerViewDelegate
UIPickerViewDataSource

class ViewController: UIViewController, UIPickerViewDelegate, UIPickerViewDataSource



ViewController Class

O




Array declaration and initialisation

The array will hold all the font types
Font types will be displayed in the picker list
Font types will also be used to set Label font type

var myPickerArray = ["Futura", "Arial",
"Courier", "Chalkduster", "Zapfino",

"AppleColorEmoji", "Didot", "MarkerFelt-Thin",
"Papyrus", "Symbol"]



viewDidLoad Implementation:

override func viewDidLoad() {
super.viewDidLoad()

myPicker.dataSource = self
myPicker.delegate = self

myPickerArray[0]
UIFont(name: myPickerArray[0], size: 40)

myLabel. text
myLabel. font



PickerView method Implementations:

func numberOfComponents(in pickerView: UIPickerView) —> Int

{
return 1
b
func pickerView(_ pickerView: UIPickerView, titleForRow row: Int, forComponent component: Int) —>
String?
{
return myPickerArray[row]
b

func pickerView(_ pickerView: UIPickerView, didSelectRow row: Int, inComponent component: Int)
{
yPickerArray[row]

myLabel.text = m
= UIFont(name: myPickerArrayl[row]l, size: 40)

myLabel. fon

~+ +

by

func pickerView(_ pickerView: UIPickerView, numberOfRowsInComponent component: Int) —> Int

{
b

return myPickerArray.count



pickerView numberOfRowsInComponent

O




numberOfComponentsInPickerView

O




Write method implementation for:

pickerView didSelectRow inComponent

myPickerArray [row]
UIFont(name: myPickerArraylrow], size: 40)

myLabel. text
myLabel. font



pickerView titleForRow forComponent

O




TableView

Carrier & 8:23 AM
Desserts

Caramel Cake

Cheese Cake

Chocolate Cake

Chocolate Mousse

Ice Cream

Strawberry Cake

e
-
¥
=

}a Vanilla Mousse










Storyboard

O

Prototype Cells

Navigation Controller Table View
Prototype Content

Table View Controller



Create TableViewController Class

O

Choose a template for your new file:

watchOS  tvOS  macOS @ Filter _

Source
[ [ R R

g 8 3 3
Ul Test Case Unit Test Case Playground Swift File

Class Class Class

(N (TN N [N

m h cr (N
Objective-C File Header File i C++ File Metal File
User Interface

\! » 5 [©)

Storyboard Launch Screen

[ Previous Next




Create TableViewController Class

Choose options for your new file:




Assign the created TableViewController class

In StO ryb O ard vai..ard ) B Mai..se) ) [B] Desserts Scene Desserts < >

ssssssss

pppppppppppppp

- MainStoryboard.storyboard
- Show “Document Outline”

- Click on the Table View Controller

—> Identity Inspector

- Custom Class = Select the correct “Class
(the one just created) from the drop-down

sssssssssss
Class DessertsTableViewController

Module

||||||||

Use Storyboard ID

User Defined Runtime Attributes

cccccccc

Label

<] <



Assign TableViewController Class

E Main...» & Main... » [B] Table View Controller Scene » [l Table View Controller

¥ Table View

» | Table View Cell Identity
E Navigation Item Prototype Cells e Dalinad

. First Responder Key Path | Type
B exit
v [E] Navigation Controlle...

» (€ Navigation Controller
@ First Responder

B exit

@ Relationship "root...

Table View

Prototype Content

11 @interfa
ce

(B)(= e @) (&= a] Noap




- Storyboard
- Add an ImageView and two Labels —
- Create a TableViewCell Class
- File - New - File
- 10S - Cocoa Touch Class - Next
- Subclass of UITableViewCell

Class: TableViewCell

Subclass of: | UlTableViewCell v

UlTableViewCell



Assign the created class to cell through ID Inspector
Make IBOutlet connections for the image and 2 labels

Desserts

Prototype Cells

Name Price

class DessertsTableViewCell: UITableViewCell {

?IBOutlet weak var myImage: UIImageView!
9IBOutlet weak var myLabel: UILabel!
IBOutlet weak var myPricelLabel: UILabel!



Set the “Cell Identifier” to

—> Click on the Prototype Cell
—> Attribute Inspector

- Table View Cell
—>Identifier

- Set to

O & O
Table View Cell

Style Custom

ldentifier DessertsTableViewCel



Set the “Cell Identifier”

T —
Indentation Q@ %@

@ Indent While Editing
(") Shows Re-order Controls

Table View Mode | Scale To Fill :
Prototype Content . wl ol

Interaction (¥ User Interaction Enabled
() Multiple Touch

I —
P T —
A TTr—

Drawing ¥ Opaque ("] Hidden




TableViewController Class

O




TableViewController Class

O




TableViewController Class

O




Configure the cell in the following method to display
the array item corresponding to the row:

override func tableView(_ tableView: UITableView, cellForRowAt indexPath: IndexPath) —>
UITableViewCell

{
let myCell = tableView.dequeueReusableCell(withIdentifier: "DessertsTableViewCell") as!

DessertsTableViewCell
Llet row = indexPath. row
myCell.myLabel.text = desserts[row]
myCell.myImage.image = UIImage(named:images[row])
myCell.myPricelLabel.text = prices[row]

return myCell



TableView with DetailView
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, o._




When user clicks on the table row
The DetailedViewController will appear
Steps:
1. Add a new ViewController to the Storyboard
2. Add Image and Label to this ViewController
3. Create a new DetailViewController Class

o Subclass of UIViewController
eclass DetailViewController: UIViewController

4. Connect the class through ID Inspector

5. Make IBOutlet connections for Image and Label
@IBOutlet weak var myLabel: UILabel!

@IBOutlet var ivDisplaylImage : UIImageView?



cellForRowAtIndexPath

o,




prepare for segue

O




DetailedViewController Implementation

O

import UIKit

class DetailViewController: UIViewController

{
@IBOutlet weak var myLabel: UILabel!
@IBOutlet var ivDisplayImage : UIImageView?

var strImageName: String!
var strCarName: String!

override func viewDidLoad()

{
super.viewDidLoad()
mylLabel.text = strCarName
self.ivDisplayImage?.image=UIImage(named : strImageName)

}

@IBAction func btnBackClicked(_ sender : AnyObject)
{

self.dismiss(animated: true, completion: nil)

}



Collection View




Storyboard:

Add CollectionView to ViewController
Add Collection View Cell to CollectionView
Add ImageView and Label to the Cell

Click on ViewController
Go to Connection Inspector
Connect:
Label and ImageView

O & F B @

Outlets Show the Connections inspector
dataSource % View Controller @)
delegate % View Controller O
prefetchDataSource

Outlet Collections
gestureRecognizers

Referencing Outlets
New Referencing Outlet

Referencing Outlet Collections

New Referencing Outlet Collection



CollectionView Cell

O

O e @ ¥ B @

Identifier MyCollectionViewCell

| -
colocuonuommm




ViewController Implementation




BH= Q& & o & |[8/[< >|[BApion

5] App Ic D General Capabilities Resource Tags Info Build Settings Build Phases Build Rules

v Appicon PROJECT Devices  Universal
3 ViewController.swift App lcon Main Interface | Main
R storyboa TARGETS
o o Device Orientation [ Portrait
[ Assets cassets = Upside Down
e 00 () App IconTests Landscape Left

Info.plist "7 App IconUITests Landscape Right
» [ ] App IconTests

» (1] App IconUlITests Status Bar Style Default
> [ Products [7) Hide status bar
") Requires full screen

¥ App Icons and Launch Images

App Icons Source ( Applcon

Launch Images Source | Use Asset Catalog

Launch Screen File | LaunchS:




App Icon Sizes

2x 3x

iPhone
Spotlight - i0S 5,6
Settings - i0S 5-9
29pt

1x 2x

iPad Settings
i0S 5-9
29pt

2x 3x

iPhone Spotlight
i0S 7-9
40pt

2x

iPad Spotlight
i0s 7-9
40pt






https://www.cocoacontrols.com/controls?language=2-swift
https://www.cocoacontrols.com/controls?language=2-swift

